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PAY & PERSONNEL CENTER NOTICE 5231 

Subj: CH-1 TO PPCINST M5231.3, COAST GUARD SERVICING PERSONNEL OFFICE MANUAL 

 
1. Purpose This notice publishes changes to PPCINST M5231.3, Coast Guard Servicing 

Personnel Office Manual. 

 
2. Action Area, district, and sector commanders, commanders of maintenance and 

logistics commands, Commander Deployable Operations Group, commanding 
officer of headquarters units, assistant commandant for directorates, Judge 
Advocate General, and special staff offices at Headquarters with SPOs 
attached shall ensure that the provisions of this manual are followed.  Internet 
release is authorized. 

  
3.  Procedures No paper distribution will be made of this Notice. Official distribution will be 

via the Coast Guard Pay & Personnel Center’s web site: 
http://www.uscg.mil/ppc/spoman.asp. 

  
4. Summary of 

Changes 
This change incorporates the contents of E-Mail ALSPO messages G/10, J/10, 
A/11, B/11 and C/11. A side bar in the margin marks the significant changes. 
Significant changes include: 
 
Part I, Direct Access/Jumps Overview: 
 
Chapter 1: Updated to reflect implementation of MyPortalDirect. 

Continued on next page 
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 4.  Summary of 

Changes 
(cont’d) 

Chapter 2: Changed title to “DA SPO User Roles and Access (HRS/HRSUP)”. 
Added Payment Approval Official (PAO) designation criteria and process. Added 
requirement SPO Authorized Personnel Roster. 
 
Chapter 3:  Changed title to “Documentation Standards”. Added Procedures for 
Completing Forms & Worksheets and Evidence Supporting Military Payroll 
Transactions, General Guidance for Servicing Personnel Offices. 
 
Chapter 4: Provides guidelines for SPOs to follow when providing services to 
members who are not permanently or temporarily assigned, for a period of more 
than 60 days, to a unit in the SPO’s area of responsibility (AOR). 
 
Part II, Pay Entitlements: Added review & approval process to the following 
sections. 

Sect Title 
5-A Basic Allowance for Subsistence 
5-B Refund of DMR for Missed Meals 
7 Career Sea Pay / Time 
8-A Officer Uniform Allowance 
8-C Supplemental Clothing Allowance 
8-D Maternity Uniform Allowance 
8-E Civilian Clothing Money Allowance 
9-A CONUS Cost of Living Allowance  
9-B OUTCONUS COLA With Dependents 
9-C OUTCONUS COLA Without Dependents 
9-D Fractional OUTCONUS COLA 
11-C Combat SGLI Allowance 
11-D Combat Tax Exclusion 
11-E Diving Duty Pay 
11-F Family Separation Allowance  
11-G Flight Deck Hazardous Duty Incentive Pay 
11-H Foreign language Proficiency Pay 
11-I Hardship Duty Pay 
11-J Hazardous Duty Incentive Pay for High Pressure Chamber 

11-K 
Hazardous Duty Incentive Pay for Visit, Board, Search and Seizure (HD  
Boarding Team Members 

11-L Imminent Danger – Hostile Fire Pay 
11-M Personal Money Allowance 
11-N Responsibility Pay 
11-O Special Duty Assignment Pay 

 

 

Continued on next page 
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4.  Summary of 
Changes 
(cont’d) 

Part II, Pay Entitlements: (cont’d) 
 
Chapter 3: Added basic navigation for pay entitlement review & approval. 
 
Section 11-A: Added "Notify PPC Customer Care of any erroneous ESACIP 
submissions. They will coordinate with PPC (ID) to have the transaction 
removed from the system". 
 
Chapter 15:  The View Paycheck page now includes LES data and 
comments/remarks for the current month and the previous 12 months. 
 
Part III, General Transactions: 
 
Chapter 4:  Removed step 7 from Divorce, Annulment or Death of Spouse 
procedure table. It said to remove the BAH eligibility date when changing 
spouse to ex-spouse. However, (MAS) needs the date in that field when 
researching pay entitlement entries that were submitted when the member was 
married. 
 
Part VI, Separations: 
 
Chapters 3, 4 and 5: Changed procedure for completing Separation pay tab to 
reflect that only the Highest Pay Grade Held field is required to be completed 
by the SPO only when the member is authorized Disability Severance Pay and 
that all other fields on this tab are "read only". The other fields are populated 
when the separation request/authorization is approved by CG PSC. 
 
Part VII, Reserve Unique Transactions: 
 
Chapter 4: Removed requirement to enter stop dates on entitlements. 
Entitlements will reflect the RELAD date as the stop date upon approving the 
RELAD. 

 

Continued on next page 
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5. Action Remove and insert the following pages. 
 

Remove Insert 
Table of Contents i thru vi Table of Contents i thru vi 
Pages I-i thru I-ii Pages I-i thru I-ii  
Pages I-1-1 thru I-2-42 Pages I-2-1 thru I-2-26 
Pages I-2-1 thru I-2-18 Pages I-2-1 thru I-2-12 
Pages I-3-1 thru I-3-28 Pages I-3-1 thru I-3-12 
(N/A New Chapter Added) Pages I-4-1 thru I-4-4 
Pages II-3-1 thru II-3-32 Pages II-3-1 thru II-3-34 
Pages II-5-A-1 thru II-5-A-18 Pages II-5-A-1 thru II-5-A-18 
Pages II-5-B-1 thru II-5-B-14 Pages II-5-B-1 thru II-5-B-12 
Pages II-7-1 thru II-7-26 Pages II-7-1 thru II-7-28 
Pages II-8-i thru II-8-ii Pages II-8-i thru II-8-ii 
Pages II-8-A-1 thru II-8-A-12 Pages II-8-A-1 thru II-8-A-12 
Pages II-8-B-1 thru II-8-B-2 Pages II-8-B-1 thru II-8-B-2 
Pages II-8-C-1 thru II-8-C-8 Pages II-8-C-1 thru II-8-C-8 
Pages II-8-D-1 thru II-8-D-8 Pages II-8-D-1 thru II-8-D-10 
Pages II-8-E-1 thru II-8-E-10 Pages II-8-E-1 thru II-8-E-10 
Pages II-9-A-1 thru II-9-A-12 Pages II-9-A-1 thru II-9-A-14 
Pages II-9-B-1 thru II-9-B-12 Pages II-9-B-1 thru II-9-B-14 
Pages II-9-C-1 thru II-9-C-12 Pages II-9-C-1 thru II-9-C-14 
Pages II-9-D-1 thru II-9-D-8 Pages II-9-D-1 thru II-9-D-10 
Pages II-11-i and II-11-ii Pages II-11-i and II-11-ii 
Pages II-11-A-19 thru II-11-A-20 Pages II-11-A-19 thru II-11-A-20 
Pages II-11-C-1 thru II-11-C-24 Pages II-11-C-1 thru II-11-C-24 
Pages II-11-D-1 thru II-11-D-22 Pages II-11-D-1 thru II-11-D-24 
Pages II-11-E-1 thru II-11-E-12 Pages II-11-E-1 thru II-11-E-14 
Pages II-11-F-1 thru II-11-F-24 Pages II-11-F-1 thru II-11-F-24 
Pages II-11-G-1 thru II-11-G-8 Pages II-11-G-1 thru II-11-G-8 
Pages II-11-H-1 thru II-11-H-20 Pages II-11-H-1 thru II-11-H-22 
Pages II-11-I-1 thru II-11-I-12 Pages II-11-I-1 thru II-11-I-12 
Pages II-11-J-1 thru II-1J-I-12 Pages II-11-J-1 thru II-11-J-12 
Pages II-11-K-1 thru II-11-K-6 Pages II-11-K-1 thru II-11-K-8 
Pages II-11-L-1 thru II-11-L-20 Pages II-11-L-1 thru II-11-L-24 
Pages II-11-M-1 thru II-11-M-12 Pages II-11-M-1 thru II-11-M-14 
Pages II-11-N-1 thru II-1-N-12 Pages II-11-N-1 thru II-1-N-12 
Pages II-11-O-1 thru II-1-O-18 Pages II-11-O-1 thru II-1-O-22 
Pages II-15-1 thru II-15-4 Pages II-15-1 thru II-15-4 
Pages III-4-69 thru III-4-70 Pages III-4-69 thru III-4-70 
Pages VI-3-1 thru VI-3-24 Pages VI-3-1 thru VI-3-24 

  

Continued on next page 
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5. Action (continued) 
 

Remove Insert 
Pages VI-4-1 thru VI-4-24 Pages VI-4-1 thru VI-4-24 
Pages VI-5-1 thru VI-5-18 Pages VI-5-1 thru VI-5-20 
Pages VII-4-77 thru VII-78 Pages VII-4-77 thru VII-78 

 
6. Environmental 
aspect and impact 
considerations 

Environmental considerations were examined in the development of this 
notice and have been determined to be not applicable. 

 
7. Forms and 
Reports 

Forms referenced in this Manual are available in USCG Adobe Forms on 
SWSIII or on the Internet at http://www.uscg.mil/ppc/forms/. 

   
8. Comments and 
Recommendations  

PPC encourages user recommended revisions and corrections to the 
Coast Guard Servicing Personnel Office Manual. Comments or 
recommendations may be submitted by sending an e-mail to PPC (P&D) at  
PPC-PF-PD@uscg.mil.  

 
 
 
 
 
J. D. PHILLIPS 
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PAY AND PERSONNEL CENTER INSTRUCTION M5231.3 
 
Subj: COAST GUARD SERVICING PERSONNEL OFFICE MANUAL (SPO MANUAL) 

  
1.  Purpose This manual instruction establishes procedures for Servicing Personnel 

Offices (SPOs): 

• It provides guidance to the SPOs on how to accurately report personnel 
events and transactions into the DA/Joint Uniform Military Pay System 
(DA/JUMPS). 

• It applies to all SPOs within the Coast Guard and the National Oceanic and 
Atmospheric Administration (NOAA). 

  
2.  Action All CG unit commanders, commanding officers, officers-in-charge, 

deputy/assistant commandants, an chiefs of headquarters staff elements with 
Servicing Personnel Offices attached shall comply with the provision of this 
manual.  Internet release is authorized. 

 
3.  Directives 
Affected 

PPCINST M5230.3, PMIS/JUMPS Analysis Manual is cancelled.  

Continued on next page
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4. Environmental 
aspect and 
impact 
considerations 

Environmental considerations were examined in the development of this 
manual instruction and have been determined to be not applicable. 

 

5.  Forms 
Availability 
 

Forms and worksheets referenced in the Personnel and Pay Procedures 
Manual, PPCINST M1000.2 (series), shall be used as the source 
documentation to enter personnel data information into DA/JUMPS.  Other 
types of communication are authorized and encouraged when an existing 
worksheet does not provide for the necessary information (i.e., E-mail).  
Applicable forms and worksheets are listed at:  
http://www.uscg.mil/ppc/forms/.  

  
6.  Change 
Management 

Changes are numbered consecutively and are issued annualy.  A PPC Notice 
(PPCNOTE) promulgates changes.  SPOs are notified by e-mail when 
changes are issued.  Interim changes are published via E-Mail ALSPO 
message. Base Commanders and Personnel Services and Support Unit 
supervisors and commanding officers of units with SPOs attached shall ensure 
an e-mail distribution list or public folder (with the ability to receive e-mail) 
is established for each SPO and that the e-mail address is provided to PPC 
(P&D). PPC (P&D) maintains the SPO Contact List, which is available at 
http://cgweb.psc.uscg.mil/spocontactlist.asp, for review and verification. 

  
7.  Comments/ 
Suggestions 

PPC relies on user input and feedback for improvement of this and other 
publications we provide.  If there are any areas that are not clear, complete 
or accurate, additional procedures that should be included, or any other 
recommendations you may have for improvement, we would like to know 
about them.  Comments or recommendations may be submitted by E-mail to 
“PPC-PF-PD@uscg.mil”. 

  
 
 
 

J. D. PHILLIPS 
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Coast Guard Servicing Personnel Office Manual 

Part I, Overview 
 

Overview CH-1 I-i 

Overview 

 
Introduction The Pay and Personnel Center  Servicing Personnel Office Manual (DA SPO 

Manual) was created to better enable Servicing Personnel Office (SPO) 
personnel in the pursuit of proper human resource management. 

 
Part Outline There are 10 Parts that comprise the DA SPO Manual: 

• Part I – Direct Access / JUMPS Overview 
• Part II – Pay Entitlements 
• Part III – General Transactions 
• Part IV – PCS Transfer 
• Part V – Reenlistments and Extensions 
• Part VI – Separations 
• Part VII – Reserve 
• Part VIII –     Accessions 
• Part IX – Joint Uniform Military Pay System (JUMPS) 
• Part X – Error Feedback, Reports, and Queries 

 
Contents This part contains the following chapters 
 

Chapter See Page 
Getting Started with Direct Access I-1-1 
DA SPO User Roles and Access (HRS/HRSUP) I-2-1 
Documentation Standards I-3-1 
Coordination of SPO Data Entry I-4-1 
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Coast Guard Servicing Personnel Office Manual 

Part I, Direct Access/Jumps Overview 

Chapter 1, Getting Started with Direct Access 

 CH-1  
 

Overview 

 
Introduction This Chapter provides the procedure for navigating Direct Access. 

 
Contents This chapter contains the following topics. 
 

Topic See Page 
Signing In  I-1-3 
Your Direct Access Password  I-1-4 
Verifying the e-mail address in your user profile I-1-5 
Using the Online Help Feature I-1-6 
Basic Navigation I-1-9 
Search Tips I-1-10 
Looking Up Department ID Numbers I-1-13 
Keyboard Shortcuts I-1-15 
Internet Explorer Keyboard Shortcuts I-1-17 
Copying & Printing I-1-19 
Direct Access Action Types I-1-21 
Worklist Reassign Operator ID Lookup I-1-22 
Using Process Scheduler’s Web Delivery Option I-1-23 
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Direct Access/JUMPS Overview 

Getting Started with DA CH-1 I-1-3 

Signing In  

 
Introduction This section provides instructions for signing on to the system. 

 
Procedure Follow the steps at 

http://www.uscg.mil/ppc/ps/index.htm#usingda/signing_in.htm to sign into 
MyPortalDirect. 

 

http://www.uscg.mil/ppc/ps/index.htm#usingda/signing_in.htm�
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Your Direct Access Password  

 
Introduction 

 

This section provides the procedures for changing your password and setting 
up forgotten password help.  
 
Passwords are a common form of authentication and are often the only barrier 
between a user and your personal information.  Choosing a good password 
keeps your personal information confidential, making it more difficult for an 
unauthorized access to your information. 

 
Procedure Follow the steps at 

http://www.uscg.mil/ppc/ps/index.htm#usingda/how_to_change_your_password.htm 
to change your password and setup forgotten password help. 

 

http://www.uscg.mil/ppc/ps/index.htm#usingda/how_to_change_your_password.htm�
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Verifying the e-mail address in your user profile 

   
Introduction Your business e-mail address may appear correct, but some user's profile 

addresses are blank or out-of-date. The profile address (which is used to send 
your reports and password resets to) is updated by changing your business e-
mail address.  

   
Procedure for 
Verifying your 
E-mail 

Follow the steps at 
http://www.uscg.mil/ppc/ps/index.htm#self_service/members/e_mail_address.htm to 
verify or update your e-mail address. 

 

http://www.uscg.mil/ppc/ps/index.htm#self_service/members/e_mail_address.htm�
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Using the Online Help Feature 

   
Information 
about the Help 
feature 

Help topics are organized into "books" covering the PeopleSoft modules that 
have been implemented in Direct-Access. Click on one of the book icons   
in the left panel of the window to explore the topics available. Click on a 
topic icon   to open the topic. 

 
 
Note: You only need to click once. This is a web page; you don't need to 
double-click items to open them. 
 
Each book contains a brief introductory topic, explaining the capabilities of 
the module. Subsequent topics provide procedures for accomplishing specific 
tasks or viewing data. 

 
Conventions 
used in the 
Online Help 
Feature 

Links are formatted as follows: 
• Most words and phrases that are underlined are links to other parts of 

the help file or other Internet/Internet web pages. Links to other web 
pages will open in a new window, while links to other parts of the 
help file will open in the window you are currently viewing. 
 

Some underlined words and phrases are expanding hot spots. These are used 
to introduce terms and acronyms you may not be familiar with. They will be 
formatted in green text. Click on them to expand the topic and then click on 
the underlined word again to dismiss the expanded text. 
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Using Index, Search and Glossary in the Online Help 

 
Introduction Use the Index, Search and Glossary features of the help file to quickly locate 

information. These features are accessed via the toolbar at the top left part of 
the Help screen: 
 

 

 
Using Search 

Using Search:  Click the  button and then type your query in the 
search text field, and click the  button. A list of topics matching your 
search will display in the area below the toolbar. Click on a topic to view it. 

 
Example of 
Search Results 

Notice how we used the old term "Qualification Codes" but were directed to 
"Competencies" (the new term) in the search results: 

 

 
Using the Index 

The index works much like the search feature. Click the  button, type 
your query into the text field that appears just beneath the tool bar. You can 
also scroll through the list without entering a keyword. 

Continued on next page 
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Using Index, Search and Glossary in the Online Help, Continued 

 
Example of 
Index Search 

Here is an example: 

 

 
Using the 
Glossary 

The Glossary can be used to lookup new terms you may not be familiar with. 

Simply click the  button and scroll through the list of terms displayed 
just below the toolbar. Select a term and read the definition in the bottom half 
of the panel. 

 
Example of 
Glossary 

Here is an example of a glossary term and its definition: 
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Basic Navigation 

   
Introduction This section provides instructions for navigating Direct Access menus. 

   
Direct Access 
Menus 

The following tutorials, available at 
http://www.uscg.mil/ppc/multimedia.asp#da, provide MyPortalDirect basic 
navigation familiarization: 
 
• Basic Navigation for All Users. This demo provides an overview of the 

new Self-Service menu and introduces some of the new features in the 
Portal.  

o Basic/Self Service Navigation Video-Demo (Video/Flash)  

o Basic/Self Service Navigation Guide (PDF)  

• Command User. This demo provides an overview of the navigation for 
Command Users  

o Command User Video-Demo (Video/Flash)  

o Command User Guide (PDF)  

• SPO and Other Users. This demo introduces the "Enterprise Menu" 
navigation.  

o Enterprise Menu Video-Demo(Video/Flash)  

o Enterprise Menu Guide(PDF)  

 

http://www.uscg.mil/ppc/multimedia.asp#da�
http://www.uscg.mil/ppc/da/portal/Self-Service_Only.htm�
http://www.uscg.mil/ppc/da/portal/PortalforSelfService.pdf�
http://www.uscg.mil/ppc/da/portal/Commander-User.htm�
http://www.uscg.mil/ppc/da/portal/PortalforCommandUser.pdf�
http://www.uscg.mil/ppc/da/portal/SPO-User.htm�
http://www.uscg.mil/ppc/da/portal/PortalSPOuser.pdf�
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Search Tips 

   
Introduction This section provides procedures for searching in Direct Access. 

   
Internet 
Explorer Find 
Function 

Since the PeopleSoft 8 application is browser-based, you can use the web 
browser's Control-F find feature to locate a string on the page. This is useful 
for large queries and search result lists. 
 
To access the browser's find function, press Ctrl+F on the keyboard or 
choose Edit > Find (on This Page)... from the Internet Explorer menu bar at 
the top of the window: 

 

   
Find Links Find Links appear on many grids so you can easily search for data in the grid 

even if it is not displayed. For example, a grid may contain 100 rows of data, 
but the page only displays the first 10. Using the grid find functionality, you 
can quickly search for a string within the 100 rows. The following is the 
navigation bar from a grid that contains the "Find" link: 
 

 

  
Employee 
Search 

Most pages require you to provide the member's employee ID number to add, 
update or view data.  

Continued on next page 
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Search Tips, Continued 

 

 

If you do not know the EmplID, provide some 
search criteria, such as the member's last name and 
department number, in the appropriate fields to 
perform a search. 
 
You do not need to complete all the fields. The 
EmplID or SSN alone are sufficient. Complete one 
or more of the other fields if you do not have the 
EmplID or SSN. 

When choosing a member from the search 
results, please verify that it’s the person you 
actually need to make changes for.  Certify the 
employee ID or national ID before making any 
changes.  
 
Since a member can have multiple records if 
they're both a Regular or Reserve Member and 
an Auxiliary Member or Civilian Employee, 
please be sure you are selecting the correct 
Employee Classification. 

    
Wildcard 
Search 

PeopleSoft applications support three wildcard features when searching for 
data. These wildcards can be helpful in finding the exact information you 
want to process. The following are the supported standard wildcard features. 
 

Character Function 

% (percent sign) Match one or more characters. 

_ (underscore) Match any single character. 

\ (back slash) Escape character -- don't treat the next character as a wildcard. 

  Continued on next page 
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Search Tips, Continued 

 
Wildcard 
Search 
Example 

A wildcard (% character) entered in the beginning of a text search string will 
display all rows containing the text. The examples below show two searches, 
one without a wildcard and one with. 
 

Without % With % 

 
 

The search without the 
wildcard did not find any 
matches. 

The search with the wild card 
located a matching entry. 
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Looking Up Department ID Numbers 

   
Finding 
Dept IDs 

If you do not know the department ID, click the magnifying glass. (Note: You 
must enter AUSCG in the SetID field, before you click the  button.)  This 
key indicates a lookup function is available.  A simple department lookup 
allows you to search by pre-set options available in the drop-down list. 

 
Select the one you want.  On Department, you may enter all or part of the 
department number and press Lookup.  Any available departments with the 
numbers you entered will return on a list.   
 
If you know a location (but no part of the department number), select the 
Advanced Search link.   

 
This will allow you to search for departments using a greater range of 
criteria.  We suggest you: 
 

• Do a search of key words in the description of the department 
(e.g., %Baltimore), or  

• Search by department type (e.g., unit, group, STA, etc.).   
•  

Remember that use of the % symbol will return any department with a 
description that contains "Baltimore".  Review the list returned and select the 
department you need from the list, or continue to run new search criteria until 
you find the department.  
 

Continued on next page 
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Looking Up Department ID Numbers, Continued 

 
Finding Dept IDs 
(continued) 

The Advanced Search link also ensures that you get a list of all the sub 
departments associated with a parent department. It allows you to search 
by the parent department's Operational Facility Code (OPFAC) number (a 
unit may have many sub departments, but it only has one OPFAC). 

 
 

   
 Click the Lookup button. If the unit has multiple department ID numbers they 

will all be listed based on the OPFAC number entered. 
Example:  The OPFAC for TRACEN Petaluma (61200) has 49 department 
ID numbers associated with it.  
 

 
Finally, print the lookup results for easy access. 
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Keyboard Shortcuts 

 
Introduction Browser Hot Keys and Access Keys allow you to quickly initiate frequently 

used processing, such as save and lookup processing, without using the 
mouse. 

  
Hot Keys and 
Access Keys 

The following is a summary of the Hot Keys and Access Keys available. A 
Hot Key performs an immediate action. For example, when in a field that has 
lookup processing, Alt-5 invokes the Lookup page. An Access Key is an Alt-
x key combination that moves the focus to a specific field on the current page. 
It does not perform any action. Pressing the Enter key invokes the processing. 
For example, Alt-1 moves focus to the Save key and pressing enter invokes 
save processing. 

   
Short Cut Keys Here is a list of short cut keys you can use. 

Hot 
Key 

Access 
Key 

Function 

 Alt 1 Moves to "Save" button in page, moves to "Search " / "Add  
button in search and lookup pages, moves to "OK" button in 
secondary page. 

 Alt 2 Moves to "Return to Search" button. 

 Alt 3 Moves to "Next in List" button. 

 Alt 4 Moves to "Previous in List" button. 

Alt 5  Invokes Lookup and Calendar processing. 

Alt 6  Invokes Pop Up menu processing. 

Alt 7  Invokes Insert Row processing in scroll/grid. 

Alt 8  Invokes Delete Row processing in scroll/grid. 

 Alt 9 Moves to menu items in breadcrumbs and New Window  
link. 

 

       Continued on next page 
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Keyboard Shortcuts, Continued 

   
Short Cut Keys 
(Continued) Hot 

Key 
Access 
Key 

Function 

Alt 0  Triggers Refresh in Expert Entry mode. 

Alt .  Invokes Next > processing in grid, scroll, result list. 

Alt ,  Invokes Previous < processing in grid, scroll, result 
list. 

Alt /  Invokes Find processing in grid, scroll, result list. 

Alt '  Invokes View All processing in grid, scroll, result 
list. 

Alt \  Toggles between modes in component, toggles 
between 

Add/  Updates in search page. 

Ctrl J  Provides details on the end user's current connection 
information. 

Enter  Invokes search processing, using the current criteria, 
when in the lookup and search pages. 

Esc  Cancels the currently active page in search, lookup,  
calendar, and secondary pages. 

 Page 
Tabs 

Each page in a component may have an Access Key  
associated with it. The underlined character in the 
tab is the Access Key for that page. 
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Internet Explorer Keyboard Shortcuts 

   
Internet 
Explorer 
Shortcuts 

You can use shortcut keys to view and explore Web pages, use the Address 
bar, work with favorites, and edit. 

 

Press this To do this 
F1 Display the Internet Explorer Help, or when in a dialog 

box, display context help on an item 
F11 Toggle between Full Screen and regular view of the 

browser window 
TAB Move forward through the items on a Web page, the 

Address bar, and the Links bar 
SHIFT+TAB Move back through the items on a Web page, the 

Address bar, and the Links bar 
ALT+HOME Go to your Home page 
SHIFT+F10 Display a shortcut menu for a link 
CTRL+TAB or 
F6 

Move forward between frames 

SHIFT+CTRL+TAB Move back between frames 
UP ARROW Scroll toward the beginning of a document 
DOWN ARROW Scroll toward the end of a document 
PAGE UP Scroll toward the beginning of a document in larger 

increments 
PAGE DOWN Scroll toward the end of a document in larger 

increments 
HOME Move to the beginning of a document 
END Move to the end of a document 
CTRL+F Find on this page 
F5 or 
CTRL+R 

Refresh the current Web page only if the time stamp 
for the Web version and your locally stored version are 
different 

CTRL+F5 Refresh the current Web page, even if the time stamp 
for the Web version and your locally stored version are 
the same 

ESC Stop downloading a page 
CTRL+O or 
CTRL+L 

Go to a new location 

CTRL+N Open a new window 

  Continued on next page 
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Internet Explorer Keyboard Shortcuts, Continued 

   
Internet 
Explorer 
Shortcuts 
(continued) 

Press this To do this 
CTRL+W Close the current window 
CTRL+S Save the current page 
CTRL+P Print the current page or active frame 
ENTER Activate a selected link 
CTRL+E Open Search in Explorer bar 
CTRL+I Open Favorites in Explorer bar 
CTRL+H Open History in Explorer bar 
CTRL+click In History or Favorites bars, open multiple folders 

 

   
Using the 
Address Bar 
Shortcuts 

 

Press this To do this 
ALT+D Select the text in the Address bar 
F4 Display the Address bar history 
CTRL+LEFT 
ARROW 

When in the Address bar, move the cursor left to the 
next logical break (. or /) 

CTRL+RIGHT 
ARROW 

When in the Address bar, move the cursor right to 
the next logical break (. or /) 

CTRL+ENTER Add "www." to the beginning and ".com" to the end 
of the text typed in the Address bar 

UP ARROW Move forward through the list of AutoComplete 
matches 

DOWN ARROW Move back through the list of AutoComplete 
matches 

  
Using Favorite 
Keyboard 
Shortcuts 

 

Press this To do this 
CTRL+D Add the current page to your favorites 
CTRL+B Open the Organize Favorites dialog box 
ALT+UP ARROW Move selected item up in the Favorites list in the 

Organize Favorites dialog box 
ALT+DOWN 
ARROW 

Move selected item down in the Favorites list in the 
Organize Favorites dialog box 
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Copying & Printing 

  
Copying while 
in Direct Access 

Press this To do this 
CTRL+X Remove the selected items and copy them to the Clipboard 
CTRL+C Copy the selected items to the Clipboard 
CTRL+V Insert the contents of the Clipboard at the selected location 
CTRL+A Select all items on the current Web page 

 

  
Copying from 
the Web - 
Procedure 

Click and hold the left mouse button while dragging the pointer over the table 
to select the data, release the mouse button. Choose Edit > Copy from the 
menu bar (or press Ctrl + C on the keyboard). Start or switch to the 
application you want to copy the data to and Choose Edit > Paste from the 
menu bar (or press Crtl + V on the keyboard). 

 
Printing 
Procedure 

Click the  link at the top of the table to display all rows. Click the 
Internet Explorer Printer  Icon on the tool bar at the top of the window, or 
choose File > Print from the menu bar to print the page. 
 
You can print individual pages of the help file by right-clicking in the topic 
window and selecting Print. In the print frames section, make sure the "Only 
the selected frame" radio button is selected before clicking OK. 
 

 
 

Continued on next page 
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Copying & Printing, Continued 

 
Procedure 
(continued) 

If you are on Coast Guard Standard Workstation III, or have Adobe Acrobat® 
installed on your computer, you can print pages to a PDF file.  The file can 
then be printed, saved or sent, via email, to another person.  To create a PDF 
file choose File > Print from the menu bar and set the printer to Acrobat PDF 
Writer. Click the OK button on the print dialog box.  PDF Writer will prompt 
you for a file a name and the location to save the PDF file. 
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Direct Access Action Types 

   
Purpose Use Action types to access data within the system. DA has four (4) general 

options to use within the system when accessing information. Based on the 
user and/or level of security they are given on the system, all of the options 
may not be available to every user.  

   
Details 

 

The action you select tells PeopleSoft the type of activity you want to 
perform. 

Action Type Action 

  
or 

  

Add actions add a new row of information. If 
you think of it in terms of a file cabinet, you are 
adding a new file folder to the filing cabinet. 

   The default when you enter a page is 
Update/Display. With Update/Display, you can 
either update or display information about a 
specific item. 
 
To update information, insert a new row of data 
by using the insert ( ) button.  
 
The only restriction when using this action type 
is when you enter or review a row of data within 
the system; the effective date must be greater 
than the date on the current row. 

  
or 

  

This action type works the same way as 
Update/Display, but will allow the user to 
review not only Current and Future rows of 
information, but also History rows of data. 

  
or 

  

Correct History is the most powerful of action 
types. When you choose this option, you can 
view, change, and insert rows of data regardless 
of the effective date. Be mindful of who you 
give this option to within your organization. 
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Worklist Reassign Operator ID Lookup 

  
Procedure Follow these steps to lookup a operator ID 
 

Step Action 
1 

Click the  button 
2 Click the  icon next to the operator ID field. 

 
3 Change the Search by field to "Description". 

 
4 Complete the description field with the percent character (%) followed by the last name of the 

person whose operator ID you wish to locate. 

 
5 Click the  button. 
6 Click on the person's name in the search results. 

 
7 You will be returned to the operator ID entry page, the operator ID field will be completed. You 

may add comments in the comment field (Comments are visible when the recipient clicks the 
button on the worklist). 

 

 
8 Click the OK button. The worklist item will be removed from your worklist. 
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Using Process Scheduler's Web Delivery Option 

   

Background Most reports use the Process Scheduler to run and deliver the report.    

   
Procedure Follow these steps to use Process Schedule’s Web delivery options 

 

Step Action 
1 Access the Process Scheduler for the report you want to run and complete the run 

control page per that report's instructions. Then, click the Run button to access the 
Process Scheduler Request page. 
 

 
2 Select Web from the Process Type drop down menu. 

 
3 Select the file format.  Not all file formats are supported by all reports. CSV and PDF 

are the most reliable. 
 
CSV = Readable by MS Excel, text editors, other spreadsheet programs and database 
applications. 
HTM = Web page 
PDF = Adobe Acrobat 

4 Click the OK button to launch the process and return to the Process Scheduler Request 
page. 

5 Click the Process Monitor link in the upper right-hand corner of the Process Scheduler 
Request page. 

 

Continued on next page 



Direct Access/JUMPS Overview 
 

I-1-24 CH-1 Getting Started with DA 

Using Process Scheduler's Web Delivery Option, Continued 

 
Step Action 

6 The Process Monitor page will display.  Click the Refresh button periodically until the 
Run Status shows "Success" and the Details link is active. It could take some time for 
the status to change if you are running a large report or the system is heavily loaded.   
 

 
 

7 Click the Details link.  The Process Detail Page will display. Click the View 
Log/Trace link. 
 

 

Continued on next page 
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Using Process Scheduler's Web Delivery Option, Continued 

  
Step Action 

8 The Report Log Viewer page will open in a new window.  Access your report by 
clicking the link with the report name and number in it (In the example below, 
cgasqrpt_476108_frm.htm is the link to the report). 

 
 
Note:  You can also right mouse click and save the report (advisable if you selected 
the CSV format). 

 
9 Your report will open and display in the web browser. Bookmark the report page and 

you can view it later (within 5 days) without having to run the report again. 
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Coast Guard Servicing Personnel Office Manual 

Part I, Direct Access/Jumps Overview 

Chapter 2, DA SPO User Roles and Access (HRS/HRSUP) 

 
Introduction This chapter discusses Direct Access User Roles for Servicing Personnel 

Offices  

 
Contents This chapter contains the following topics. 
 

Topic See Page 
Payment Approving Officials I-2-3 
Procedures for Authorizing SPO Users  
(HRS & HRSUP) 

I-2-5 

SPO Authorized Personnel Roster I-2-11 
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Payment Approving Officials 

 

Discussion The requirements to sign various forms and worksheets in this manual and to 
electronically sign Direct Access transactions are necessary to affirm and give 
legal credence to the information contained on the form or in the transaction.  
The Commanding Officer (CO) should avoid situations where the 
responsible officer lacks the knowledge or time to validate the 
information and may sign as a formality. 

  

Reference (a) COMDTINST M5000.3 (series), CG Regulations 
• Chapter 7-1-8, Administration of Oaths 
• Chapter 7-1-9, Signing Official Correspondence 

(b) COMDTINST M7210.1 (series), Certifying and Disbursing Manual 

  

Authority to 
sign forms and 
worksheets 

The CO may authorize in writing for officers, Chief Petty Officers, First Class 
Petty Officers, and Second Class Petty Officers to sign forms and worksheets 
“by direction”.  These “by direction” authorizations must be documented, and 
maintained locally in an authorization file to support future audit inquiries. 
The authorizations are subject to the following restrictions. 

• Only officers, the Master Chief Petty Officer of the Coast Guard (MCPO-
CG), Commandant designated Command Master Chiefs, and designated 
recruiting office Chief Petty Officers and Petty Officers may administer 
enlisted oaths and sign enlistment contracts. 

• Only Officers, the MCPO-CG, Commandant designated Command Master 
Chiefs, and permanently assigned Enlisted Officers-in-Charge may 
administer reenlistment and extension of enlistments oaths and sign the 
appropriate reenlistment or extension document. 

• The “by direction” authority granted to Second Class Petty Officers (PO2) 
shall normally be limited to routine transactions such as leave and personnel 
transactions.  PO2s shall only be given authority to sign specific Direct 
Access transactions “by direction” in cases where there is a shortage of 
Officers, Chief Petty Officers, and First Class Petty Officers. 

• Only the CO may sign the PCS Departing Worksheet (CG-2000) or the 
Advances Worksheet (CG-2010) when the member is requesting Advance 
Pay & Allowances or Advance Pay with liquidation period in excess of 12 
months. 

• Only the CO may sign Adverse Administrative Remarks (CG-3307) entries. 
  

Continued on next page 
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Payment Approving Officials, Continued 

 
Authority to 
sign Pay and 
Personnel 
Transactions 

The Commanding Officer (CO) of a unit with a SPO must nominate at least 
one Officer, Chief Petty Officer, First Class Petty Officer, Second Class Petty 
Officer, or Civilian employee in grade GS-7 or above, for designation by PPC 
(MAS) as a Payment Approving Official (PAO)/SPO Supervisor-Auditor 

• Only properly designated PAOs/SPO Supervisors-Auditors have the 
authority to approve Direct Access transactions for transmission to PPC. 

• Only properly designated PAOs (see Payment Approving Officials’ 
responsibilities and liabilities below) may have SPO Supervisor/Auditor 
(CGHRSUP) capability in Direct Access. 

   
Payment 
Approving 
Officials’ 
responsibilities 
and liabilities 

It is Coast Guard Policy that PAOs have the same level of financial liability 
as an Authorized Certifying Officer (ACO), as described in Chapter 1 of 
Certifying and Disbursing Manual. Thus, if a PAO incorrectly certifies a 
document to an ACO that directly results in an erroneous or improper 
payment, the PAO is responsible for the error. PAOs remain fully 
accountable to the Coast Guard and may be found to have pecuniary liability; 
and/or may have their personal evaluations (OER/CIV Performance 
Appraisal/Enlisted Employee Review) impacted by such action by an official 
in their chain with evaluation approving authority. 

  
Designation 
Procedure for 
PAO 

PAO designations and Direct Access Human Resource Site Supervisor 
(HRSUP) user role authorizations are processed together.  See Procedures for 
Authorizing SPO Users (HRS & HRSUP), on page I-2-5 of this chapter for 
the PAO/HRSUP user role designation procedure. 
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Procedures for Authorizing SPO Users (HRS & HRSUP) 

 
Purpose This section provides guidelines for determining who will be granted Human 

Resource Site (HRS) or HRS Supervisor/PAO access at SPOs and procedures 
for granting HRS access to Direct Access for users assigned to Servicing 
Personnel Offices (SPOs).  

   
Form HRS and HRSUP/PAO user requests/designations are submitted on form 

CG-7421B, Direct Access User Access Authorization and Payment 
Approving Official (PAO) Designation. See exhibit 1-2-1 on page 9 of this 
chapter. Fax completed access forms to PPC (ps&r) at (785) 339-2297 for 
processing. 

  
HRS Access 
Defined 

HRS access permits a Direct Access user to create transactions, which effect 
changes in a member’s pay entitlements.  HRS users can also access and 
maintain non-payroll data, such as competencies, awards, enlisted employee 
reviews, etc.  HRS access duplicates the Self-Service for Employees and Self-
Service for Commands roles to allow users at (SPOs) to service members and 
commands that do not have access to Direct Access or are administratively 
limited. 

  
SPO 
Supervisors/ 
Payment 
Approving 
Officials – 
HRSUP Access 
Defined 

HRS Supervisor (HRSUP) role users have the ability to release Direct Access 
transactions that require approval.  HRSUP role users are also designated 
Payment Approving Officials (PAOs). See Payment Approving Officials on 
page I-2-3 of this chapter for PAO duties and responsibilities. Certain Direct 
Access entitlements transactions require review and approval before they can 
be released for processing.  Approval of these transactions is limited to 
properly designated Pay Approving Officials (PAOs).  PAOs are assigned the 
HRS Supervisor (HRSUP) role in Direct Access. 
 
The Commanding Officer of a unit with a SPO must nominate at least one 
person for designation by PPC (MAS) as a Payment Approving Official 
(PAO).  Commanding Officers may designate as many PAOs as necessary to 
meet the SPO’s needs and maintain a smooth workflow while ensuring the 
requirements for segregation of duties are complied with. The approver of a 
pay or accession transaction cannot be the originator of the transaction. 

 

Continued on next page 



Direct Access/JUMPS Overview 
 

I-2-6 CH-1 DA SPO User Roles and Access (HRS/HRSUP) 

Procedures for Authorizing SPO Users (HRS & HRSUP), 
Continued 

  
Prerequisites 
for 
HRSUP/PAO 
Designation 

PAOs must be E-6 / GS-7 or above. E-5’s may be recommended for 
designation only if extenuating circumstances create a situation where E-6’s 
and above are not available for designation. Recommendations are from 
Commanding Officers of units with SPOs to the Pay and Personnel Center 
(Military Accounts Support Branch). 

 
Prerequisites 
for HRSUP/ 
PAO 
Designation 
(cont’d) 

PAOs must be E-6/GS-7 or above.  E-5’s may be recommended for 
designation only if extenuating circumstances create a situation where E-6’s 
and above are not available for designation. 
 
Minimum requirements for designation include:  
 
• Being in proper billet for this authority. 
• Being the proper rank. 
• Having successfully completed the ICOFR online training course (Course 

code 810047). 
• Having successfully completed the PAO online training course (Course 

code 502360). 
 
If an E-5 is being recommended for PAO, the Authorizing Official must 
attach a letter to Form CG-7421B that describes the justification for PAO 
responsibilities being granted to an E-5 (as prescribed in block 8 on Form 
CG-7421B).  
 
Upon verification of the minimum requirements, and application approval, 
PPC will provide a formal letter of designation to the member, via the chain 
of command.  (The letter and all minimum requirements supporting 
documentation must be maintained at the SPO or unit and be made available 
for external review and audit, to substantiate PAO application due process.)   
 
• PAOs may not perform any of the duties of a PAO until receipt of email 

notification by PPC (PS&R). 
 

Continued on next page 
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Procedures for Authorizing SPO Users (HRS & HRSUP), 
Continued 

 
Online 
Training 
Courses / 
Competency 
Code 

The PAO and ICOFR online training courses can be accessed via the Coast 
Guard Portal (https://cgportal.uscg.mil/) or by accessing the Learning 
Management System (LMS) (https://elearning.uscg.mil/). Both courses are 
listed in the Acquisitions catalog.  
 
Both courses must be completed/reviewed annually during order for 
PAO/HSRUP designations to remain in effect. 

  
Tracking 
Course 
Completions 

PAO and ICOFR course completions can be tracked in the Training 
Management Tool (TMT). For individuals who need to obtain the PAO 
competency (current and prospective), their unit Training Officers will need 
to assign the PAO competency to that individual within TMT.  Once the unit 
Training Officer has assigned the PAO competency to the individual, their 
course completions will be marked as complete in TMT. If the training officer 
does not do this, an individual’s training completion will not be recorded in 
TMT.  
 
Individuals may also print their LMS transcript, which can be accessed under 
the My Account link in the LMS, for proof of completion. 
 
Upon successful completion of the PAO and ICOFR courses the PAO -
Payment Approving Official competency code may be assigned in Direct 
Access and certified in TMT. 

  
Maintaining 
PAO status  

All PAOs must take the required training by 1 August, 2011 to maintain current 
PAO status.  Beginning in 2012, all PAOs must be re-designated by 
31 December each year, requiring prospective PAOs to repeat the online training 
courses, submit a new Form CG-7421B, and accompanying letters, if required. 
 
Annually, during the month of January, PPC will verify those who have not 
completed the re-designation requirements and suspend PAO privileges for 
those individuals not in compliance. 

 

Continued on next page 
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Procedures for Authorizing SPO Users (HRS & HRSUP), 
Continued 

 
Terminating  
Privileges 

Access terminates automatically upon transfer or separation. There is no need 
to notify PPC when a member is transferred or is separated:  
 
• Access, to all but self-service applications, will automatically terminate 

when a military member departs on PCS orders. 
• All access to Direct Access will automatically be revoked when a military 

member is separated from the service. 
 
If a designated PAO is removed from his or her PAO position prior to the end 
of the year, the Commanding Officer shall notify PPC (MAS) by formal letter 
and must cite the reasons and effective dates.   
 
When the PAO designation is no longer required, the unit TO should remove 
the competency requirement from TMT. 

  



Exhibit 1-2-1 

 

U.S. DEPARTMENT OF  
HOMELAND SECURITY 
U. S. Coast Guard 
CG-7421B (Rev. 02-11) 

DIRECT ACCESS USER ACCESS AUTHORIZATION AND 
PAYMENT APPROVING OFFICIAL (PAO) DESIGNATION 

1. User’s Name (Last, First, MI.) (Please print or type) 
      

2. Rank/Rate: 
      

3. Employee ID #  
      

4. Dept ID & Unit Name (Include Staff Symbol) 
      

5. Area Code & Phone Number: 
      

6. e-Mail address: 
      

7. User Role Description (Note: See Chapter 1 of the Personnel and Pay Procedures Manual, PPCINST 
M1000.2(series) for an explanation of user roles common to field units). (Include current roles, this 
authorization supersedes all of your previous authorizations): 
 

 CGSSCMD--Command User (evals, drills, Airport Terminal, etc.) 
 CGEMPREV -- Employee Review Only (not needed if you have CGSSCMD or CGHRS) 
 CGRSVDRL – Schedule, Edit and Approve Reserve IDT Drills (Only) 
 CGRSVMGR – Create, review, and endorse requests for reserve orders. 
 CGAIRTRM--Airport Terminal Only (Relocation Specialists/Housing Office)   
 CGFIELDADM--Unit with access to Member Competencies (Quals, Awards & Schools) (Route request 
through your Servicing Personnel Office – Per Pay & Personnel Procedures Manual, PPCINST 
M1000.2(series), Chap 1.)  

 CGGWIS--Global Workforce Inquiry System (Provides View Only Access to Personal Data) 
 CGHRS -- (SPO) DEPT ID _________________  (See Chapter 1 of the CG SPO Manual, PPCINST 
M5231.3(series) for rules) 

 CGAPPL – Applicant Data (Use with CGHRS for accessions. This role is necessary to create 
applicant IDs. Cannot be selected with CGHRSUP.) 

 CGHRSUP—(SUPERVISOR, Payment Approving Official (PAO)) (Application must be approved by 
PPC (MAS)). (See Chapter 1 of the CG SPO Manual, PPCINST M5231.3(series)) 

 CGSIPDR (SPO Access to the EI-PDR via WebNow - also complete form CG-7421D) 

PPC (MAS) PAO Designation Approved by (name/signature): _________________________ 
Date:__________ 

 CGMRS — Medical Readiness System Clinical Access (Med care providers) 
 CGTRNOFF – Electronic Training Request (ETR). Unit ESOs. 
 CGFTESO – Unit Educational Services Officer. Unit ESOs. 

 CGSECURN--Unit Security Manager (View Only)  
 CGSECUVW--Area/Dist Security Manager (View Only). Fax completed form to COMDT (CG-86) at 202-
372-3950 for approval. CG-86 will forward to PPC. 

CG-86 Name/Sign:_____________________________________________ Date:________________ 
 CGTRNFAC--Training Center (TAS Course Sessions)   
 CGTRNTQC--TQC/TAS Course Scheduler  
 CGASGN--CGPSC (epm/opm/rpm) or District/PSSU/BASE Reserve Assignment Officer 
 CGRSVISC/CGRSVORD—Reserve Orders Approval/Funding, District (r)/PSSUs only. 
 Others Not Listed. Please describe (in the space below) what you need to access in DA: 

Revocation: 
Direct Access Roles are 
automatically terminated upon 
PCS, separation, retirement, 
reassignment of duties (Fleet-Ups) 
and change of organization (inter-
office transfer).  
 
CGHRSUP user roles for PAOs 
are automatically terminated each 
fiscal year unless the PAO 
completes annual required training 
and is re-designated in 
accordance with Chapter 1 of CG 
SPO Manual, PPCINST 
M5231.3(series) 
 
Users who have been reassigned 
(PCS, Change of Department IDs) 
will retain Self-Service access. 
 
The user role termination process 
is kicked off by submission of a 
PCS departing endorsement. If the 
member submits a new access 
form, and it is processed by PPC 
before the SPO submits the PCS 
departing endorsement, the 
system will terminate the new 
access. Please be sure to submit 
transactions in a timely manner. 
 
If Revocation is due to reasons 
other than those listed above 
contact PPC Customer Care via 
on-line trouble-ticket at 
http://www.uscg.mil/ppc/ccb or 
http://cgweb.ppc.uscg.mil/ccb/ or 
via email at PPC-DG-
CustomerCare@uscg.mil  

8. Authorizing Official (Signature & Typed or printed name, Rank, Title (“By direction” is not authorized. Only the CO/OIC, XO/XPO or 
Division/Branch Chiefs at HQs/DCMS/CGPSC/PPC/FORCECOM/OPCOM (and their sub-units), Districts or Sectors may sign) & Phone Number: 
I certify that the access I have authorized is based on an official need.  I am aware of the general functionality I have authorized and I am aware of 
what this will allow this member/employee to complete. If this is for a PAO Designation, I certify the member has completed online mandatory 
training requirements.  If I have recommended an E5 be designated as a PAO, I have attached required justification. If this is for a contractor, the 
Contracting Officer’s Technical Representative (COTR) signs as AO. 

 
 __________________________________________________________________________ _______________________ 
Signature AND PRINTED or TYPED Name,   Rank, Title,       Area Code & Phone (ext) 

9 Date: 

Privacy Act Statement 
AUTHORITY:  Executive Order 10450, 9397; and Public Law 99-474, the Computer Fraud and Abuse Act. 
PRINCIPAL PURPOSE: To record names, signatures, and other identifiers for the purpose of identifying individuals requesting access to U. S. 

Coast Guard (USCG) systems and information. NOTE: Records may be maintained in both electronic and/or paper form. 
ROUTINE USES:  None. 
DISCLOSURE:  Disclosure of this information is voluntary; however, failure to provide the requested information may impede, delay or 

prevent further processing of this request. 
Acknowledgment: I understand that I am authorized to access the Direct Access system and that accessing it for purposes beyond the Scope of 
Authorization is a violation of Federal law (18 U.S.C. 1030 et al) (Note: Refer to the Automated Information Systems (AIS) User Acknowledgement 
Form (CG-5500A), which is required for all U.S. Coast Guard AIS users, it contains the full Scope of Authorization and Acknowledgement.) 
10. User's Signature: 11. Date:  Fax to: (785) 339-2297 

(fax only page 1, do not fax instructions) 
U.S. DEPT. OF HOMELAND SECURITY, USCG, CG-7421B (Rev. 02-11) 
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DA SPO User Roles and Access (HRS/HRSUP) CH-1 I-2-11 

SPO Authorized Personnel Roster 

  
SPO Staffs Active duty, reserve and civilian employees permanently assigned to a 

position in one of the existing SPOs may be granted HRS access in Direct 
Access.  A Yeoman, temporarily assigned to a SPO, may be granted access. 
SPO staff assignments/approval authorities must be documented, in a SPO 
Authorized Personnel Roster, showing the name, initials, signature, role, date 
arrived, and date departed from the SPO.  This roster must be continually 
updated and a historical chronology maintained to substantiate the approval 
authorities executed by these members. See roster example below. 
 

 
Exhibit 1-2-2: 

SPO AUTHORIZED PERSONNEL ROSTER 

Name, last, first, MI Initials Signature 

Role:  Specify 
Data Entry(E), 
or Reviewer-

Approver (RA) 

Date 
arrived on 

duty at 
SPO 

Date 
departed 

from SPO 
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Chapter 3, Documentation Standards 

 
Introduction This chapter provides the supporting documentation standards for Direct 

Access pay transactions. 

 
Contents This chapter contains the following topics. 
 

Topic See Page 
Document Processing Standards I-3-3 
Evidence Supporting Military Payroll Transactions 
General Guidance for Servicing Personnel Offices 

I-3-9 
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Documentation Standards CH-1 1-3-3 

Document Processing Standards 

  
Introduction Much of the documentation in the SPO-PDR supports the validity of 

transactions within DA as such; it is critical that this documentation be 
accurate, authorized, and approved and appropriate for the transaction it 
supports.  The examples presented in this section address the correct 
preparation of documents and show examples of correct and incorrect 
processing.  Clear and correct processing can make the difference between 
full compliance with internal control for financial reporting standards; or the 
inability to prove the accuracy of DA transactions.  Attention to detail is 
critical to ensure that the supporting documentation is a complete and 
accurate match to data contained within DA. 

  
Error 
Corrections 

(Figures 1 and 2) 
Corrections to forms, worksheets and checklists should be legible to enable an 
outside reviewer to easily read and understand the change without prior 
knowledge or prompting.  If space on the document does not permit for a 
legible, easily understood correction, either write it on the back of the 
document or attach a separate sheet.  To clearly identify the correction, place 
a reference at the point of correction such as, “see back” or “see attached 
sheet,” on the original document, and initial and date the correction. 

Example of Improper Error Correction (Figure 1) 

 
  

Continued on next page 

Writing an error correction in a small 
space makes it hard to follow.  Write the 
correction on the back of the document 
or prepare a separate explanation sheet 
and attach it to the worksheet to clearly 
explain the correction. 
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Document Processing Standards, Continued 

  
Error Corrections (cont’d)  

Example of Proper Error Correction (Figure 2) 

 
 

 
Proper 
Signatures and 
Dates 

(Figures 3 and 4) 
An unsigned form is not sufficient evidence of review or approval.  A 
signature is defined as the signing of one’s name (in cursive) in the 
appropriate block of a particular form.  Simply printing the name of the 
reviewer or approving official is not acceptable.  As a best practice, all SPO 
approval signatures should be listed on the SPO Authorized Personnel Roster 
shown in section 1.6. 

  

Continued on next page 

Here, the original document refers to an 
attached sheet which will explain the 
correction, indicate who made it and why, 
with the dated initials or signature, 
demonstrating authorization and 
accountability for the correction. 



Direct Access/JUMPS Overview 

Documentation Standards CH-1 1-3-5 

Document Processing Standards, Continued 

  
Proper Signatures and Dates (cont’d)  
 

Example of Improper Signatures and Dates (Figure 3) 

 

Example of Proper Signatures and Dates (Figure 4) 

 

  
Completing 
Checklists 

(Figures 5, 6 and 7)  
All checklists must be filled out completely, with each line individually filled 
out.  Each line represents an action for which a Yeoman is personally 
responsible and accountable, and must include both data entry and reviewer 
initials to demonstrate appropriate segregation of duties.  If a particular 
checklist line does not apply, it should be marked “N/A” (not applicable) to 
demonstrate that it was not missed or ignored.  

 

Continued on next page 

The signature must 
be a signature and 
NOT a PRINTED 
NAME.  Signature 
lines and dates 
MUST be filled in 
and not left blank. 

Here each 
line has 
been signed 
and dated, 
as required. 
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Document Processing Standards, Continued 

  
Completing 
Checklists 
(cont’d) 

Initialing the first box and drawing a line through subsequent boxes (“sign 
and line”) is not an acceptable approval practice and will fail tests performed 
by external auditors.  Although this practice is used in other functions across 
USCG, it does not provide sufficient evidence of action, review and/or 
approval for audit since it does support that each step/action was actually 
approved.  Only by initialing each line can an auditor gain assurance that the 
action the line item represents was actually taken, reviewed and/or approved. 

 
Example of Improperly Completed Checklist (Figure 5) 

 

Continued on next page 

Blank lines indicate a 
check that needed to be 
performed but wasn’t.  
This will not pass an 
external audit. 
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Documentation Standards CH-1 1-3-7 

Document Processing Standards, Continued 

Example of Improperly Completed Checklist (Figure 6) 
 

 

Continued on next page 

Sign and line, a common 
practice, leaves it open to 
interpretation if the data 
entry person or reviewer 
actually performed all the 
tasks. indicated. 
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Document Processing Standards, Continued 

Example of Properly Completed Checklist (Figure 7) 

 

  

On this 
checklist each 
line is 
separately 
initialed.  Also, 
it is clear that 
the data entry 
and review were 
done by 
different people, 
indicating a 
segregation of 
duties.  This can 
be confirmed 
against the 
authorized data 
entry and 
reviewer roster 
illustrated in 
Section 1.6.7 
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Evidence Supporting Military Payroll Transactions 
General Guidance for Servicing Personnel Offices 

 
Reference Enclosure (6) to the Military Personnel Data Records (PDR) System Manual, 

COMDTINST M1080.10 (series), prescribes the required supporting 
evidence for material military payroll transactions. The matrix lists the source 
document (memo, message, email, form/worksheet), filing location and 
retention period.  
 
The matrix is not all-inclusive and will be periodically updated to 
accommodate policy changes and to increase its comprehensiveness.  

 
Supporting 
Documentation  

Forms/worksheets, which are properly completed, as described in the 
Document Processing Standards section of this chapter, bearing the 
authorizing official’s signature serve as sufficient supporting documentation 
for most DA/JUMPS transactions. Accession and dependency changes 
require additional legal documents such as: 
 
• Birth certificate(s) for dependent child(ren) 
• Marriage certificate (for spouse) 
• Death certificate (for spouse or dependent children) 
• Final or interlocutory divorce decree (for former spouse) 
 
Legal documents submitted to the SPO for processing and inclusion in the 
SPO PDR shall be originals, notarized copies or certified to be true copies. 
The procedure for creating certified to be true copies is: 

 
Step Action 

1 Member provides an original or notarized document bearing the seal of the issuing 
authority (e.g. county registrar, clerk of the court, etc.) or notary. 
Note: Documents notarized by commissioned officers of the armed forces of the 
United States are valid without a seal. 

2 Authorized USCG employee or service member makes a photo static copy of the 
document. 
Handwrites or stamps “Certified to be a true copy” on each page of the photocopy. 
Prints his/her first name, middle initial, last name and rate/rank along with the date 
below Certified to be a true copy, leaving sufficient for their signature.  

3 Signs, above their name, in blue ink. 
4 Returns original to member. 

  

Continued on next page 

http://www.uscg.mil/directives/cim/1000-1999/CIM_1080_10I.pdf�
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Evidence Supporting Military Payroll Transactions 
General Guidance for Servicing Personnel Offices, Continued 

 
Electronically 
Imaged 
Documents and 
Digital 
Signatures 

A SPO, at the supervisor’s discretion, may accept scanned, emailed, and 
faxed supporting documentation, in the interest of providing timely service, 
with the understanding that original, hard-copy documents are forthcoming. 
The SPO must track hard copy delivery ensuring that updates are received 
within seven working days for CONUS shore units, 15 working days for 
OUTCONUS shore units and 30 days for deployed units.  

  
Importance of 
Evidence 

Each yeoman (YN) is responsible for ensuring that transactions are valid 
when processing payroll transactions for military payroll (MILPAY).  The 
Coast Guard employs many documents, and in the process of ensuring payroll 
transactions are promptly entered, the YN is confronted with many types of 
evidence.  Often there are many options as to what to accept or reject as 
supporting evidence.  This section provides general criteria to YNs to 
determine acceptable documentary evidence to support MILPAY 
transactions. 

 
Evidence that 
can be relied 
upon 

This evidence includes source documents that are required by the Personnel 
Data Record (PDR) Manual and USCG/DOD/VA forms that have been 
specifically established to document the processing of a transaction.  This 
documentation is specifically identified in USCG guidance (PDR Manual, 
PERSMAN, PPPM, SPO Manual etc.) and therefore is considered 
authoritative and sufficient.  One of the most important aspects of supporting 
evidence is consistency.  Consistency is demonstrated in the development of 
the PDR through the routine use of source documents, (SSN Card, Birth 
Certificate, Marriage Certificate, Orders) supported by a summary checklist 
(e.g., DD-1966) or a worksheet (e.g., BAH Dependency Worksheet, 
CG-2020).  These checklists and worksheets comprise sufficient source 
documentation (reliable because they were generated by a reliable external 
source) with member and/or higher level review to provide both documentary 
and testimonial evidence that a transaction is supported, approved, and 
correct.  It also supports that a system of internal controls is in place and 
operating effectively.  That is, of course, if the checklist or worksheet has 
been properly and completely filled out, as designed. 

Continued on next page 
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Evidence Supporting Military Payroll Transactions 
General Guidance for Servicing Personnel Offices, Continued 

 
Alternative 
Evidence 

Alternative evidence should not be rejected as a standard practice.  However, 
certain judgments need to be made before requesting or accepting additional 
evidence, or rejecting evidence.  Some common circumstances are described 
below 

 
Accepting a 
copy versus an 
original 

The main risk with accepting a copy is that it may have been altered in some 
way, a highly plausible situation with the use of computers.  To accept a 
copy, consider the source of the copy.  Also, is there additional authentication 
such as a stamp with a signature indicating that the copy is a true copy, and 
has been attested to, are/or there issues with legibility that may indicate the 
document has been altered? 

 
Accepting a 
non-standard 
source 

An example of a non-standard source includes email or a report that may 
provide the necessary supporting information.  In other words, evidence other 
than that prescribed in official guidance.  This kind of evidence presents the 
following concerns:   

 
• What is the source of the non-standard information…who created it (is this 

an authorized person, do you know who they are and what their role is)? 
 

• Is it necessary to use this supporting information, or is the standard source 
available or can it be obtained?  If the standard documents can be obtained 
or used, always use them, as they are an established part of the process. 
 

• Document instances where an alternative has been used and exercise 
professional judgment when accepting non-standard supporting data.  Keep 
in mind that this transaction may be reviewed or questioned years from now 
when you are no longer available to explain your reasons for accepting this 
alternate source.  Always include an explanation on the alternative 
document if space permits, or attach another page to include this 
explanation.  Print, sign, and date your explanation. 

Continued on next page 
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Evidence Supporting Military Payroll Transactions 
General Guidance for Servicing Personnel Offices, Continued 

 
Combine 
sources 

Often the combination of alternative source documents provides sufficient 
evidence to support the transaction where a single alternate source document 
may be questioned: 

 
• Consider other forms designed for supporting related transactions that also 

contain the necessary information to support the validity of this transaction. 
 

• Document the use of alternative source documents in the file.  Explain your 
use of combined sources, sign, and date it. 
 

• Forward your identified alternatives to PPC to consider including them as 
part of the standard documentation options. 

 
Additional 
guidance 

Providing adequate evidence of transactions involves applying judgment, 
which will continue to be a major part of managing military pay.  For 
those who may not have the experience necessary to make an informed 
judgment, it may be necessary to ask more experienced personnel for advice.  
Within each SPO, this would involve junior personnel routinely asking more 
experienced personnel.  If a situation arises that falls out of the experience of 
members of the SPO, PPC will provide guidance to resolve the issue. 
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Chapter 4, Coordination of SPO Data Entry 

 
Introduction This chapter provides guidelines for SPOs to follow when providing services 

to members who are not permanently or temporarily assigned, for a period of 
more than 60 days, to a unit in the SPO’s area of responsibility (AOR). 

    
In this chapter This chapter contains the following topics. 
 

Topic See Page 
Data Entry Responsibility  I-4-3 

  



Direct Access/JUMPS Overview 
 

I-4-2 CH-1 Coordination of SPO Data Entry 
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Data Entry Responsibility 

   
Introduction This section provides guidelines for coordinating data entry responsibility 

with other SPOs. 

  
Reference (a) Military Personnel Data Records (PDR) System, COMDTINST 

M1080.10 (series) 
(b) Pay & Personnel Center Servicing Personnel Office (SPO) Online 

Manual 

  
Discussion Transactions processed at SPOs other than the member’s “home SPO” can be 

executed in Direct Access (DA) without knowledge, review, or approval of 
the home SPO. For example, a non-home SPO may unknowingly enter an 
inaccurate transaction into DA that could have been completed correctly 
based on the home SPO’s more in-depth understanding of the member’s 
unique circumstances.  Moreover, a service member could potentially “SPO 
shop” for an answer to an entitlement question until the desired response is 
received.    

  
Review of SPO 
PDR required 
for accurate 
data entry 

Conducting a review of the SPO PDR is an important, first step, in the 
process of creating an accurate pay transaction. SPOs should not enter 
transactions in DA for: 
 
• Members who are not permanently or temporarily assigned, for a period of 

more than 60 days, to a unit in the SPO’s AOR.  
• Permanently or temporarily assigned personnel until they have received and 

had the opportunity to review the SPO PDR from the member’s previous or 
home SPO per paragraphs 2.C and 2.D of reference (a). 

 
Reference (a), paragraph 2.C.3, provides the procedure to follow in the event 
the SPO PDR is not received within 5 days of the member’s reporting for 
permanent or temporary duty. 

  

Continued on next page 
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Coordination 
between SPOs 
is required in 
unusual or 
urgent 
situations 

A transaction may be input by other than a member’s home SPO if delaying 
the transaction (to review the SPO PDR or transmit the information to the 
home SPO) would result in a personal financial hardship to the member or 
denial of a benefit or privilege for the member and/or dependents.  
 
If possible, the member’s home SPO should be contacted and consent 
obtained before submitting the transaction. 
 
All required supporting documentation must be sent to the home SPO as soon 
as practicable after entering the transaction. 

  
Reports The following reports are available to help identify and contact the 

responsible SPO based on the member’s permanently assigned unit: 
 
• The Servicing Personnel Office to Unit Relationship Report provides a 

listing of all units and the corresponding responsible SPO. 
 
• The Servicing Personnel Office Contact List provides a listing of e-mail 

addresses, points of contact, and phone numbers for SPOs. 
 

Both of these reports are available on PPC’s intranet/CGWEB site at: 
http://cgweb.ppc.uscg.mil/spocontactlist.asp  
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